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Overview 
This document is meant to assist in guiding you through setting up and developing with a CL-713/714 
display in CODESYS. 

 
INSTALLING PACKAGE 

To add the CL-713/714 device to CODESYS you will first need to obtain the .package file, which can be 
downloaded from the following location: 

 *DOWNLOAD .PACKAGE FILE HERE* 

Once downloaded you will need to install it into your CODESYS environment. 

1. Launch your CODESYS Installer 
 

 
 

2. Select “Change” and then “Install File(s)” 
 

 
 

HED, Inc. 
CL-713/714:  CODESYS 

https://www.hedcontrols.com/HED-Files/Resources/Product-Resources/HED_CL-713_CL-714_CODESYS_1.0.0.7.zip
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3. Navigate to and select the .package file that was downloaded 

 
 

Note: CODESYS may warn that the package file is not signed and prompts you if you would like 
to continue with the installation, continue with the installation. Once the process is complete you 
can launch CODESYS and have the ability to add this device to your project. 

 

CREATING A PROJECT 

1. Launch CODESYS and select File->New Project 
2. Select Standard Project 

 

 
 

3. When it launches it will ask what Device and Language you would like to use, for the Device 
choose the HED CL-713/714 Controller 
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ADDING I/O 

1. To add I/O to the CL-713/714 right click the top-level device and then select Add Device 
2. Under Miscellaneous follow the tree down until you see Connector A. Select that and click Add 

Device. 
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3. After being added your Device tree should look similar to this: 
 

 
 
 
 

4. To add IO you can right click on any of the <Empty> sockets, select Plug Device and choose an 
IO from the list 
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Each IO has a Pin associated with it letting you know what pins can be configured for what IO: 
 

 
 

As a note, you can configure a pin with an input and an output and the system will not flag an 
error so be careful and keep track of what pins are configured 

5. It is highly recommended that you adjust the PLC Settings to allow the use of symbolic access of 
IO to make programming easier. You can do this by double clicking the CL-713/714 Device and 
going to the PLC Settings. 
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Keep in mind that this setting is a per project setting and will need to be done for every new 
project that you do (the property is tied to project not workspace). 

 

I/O TYPES AND CONFIGURATION 

STB/STG/TRISTATE INPUTS 

STB, STG, and TRISTATE inputs refer to digital inputs where the input is ON when connected to their 
designated type and OFF when not i.e. STB is ON when it sees battery voltage and OFF when it see 
ground and vice versa for STG, it is ON when it sees ground and OFF when it sees battery voltage. 
TRISTATE specifically can detect when connected to a source, ground, or open. 

All three of these inputs have 2 properties associated with them for configuration, DebounceTimeOn and 
DebounceTimeOff 

 

Both of these values default to 5 with a unit of 10mS, so by default the debounce time for both is 50mS. 
Debounce is a property that the input must see the value for at least this long to be considered ON/OFF. 

For example, a STB input sees battery voltage, it must see that voltage for at least 50mS before the input 
will consider it valid and report the input as ON. With the symbolic IO enabled, accessing the input value 
would be done from looking at the input property. 
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RTD INPUT 

RTD inputs refer to inputs that read in a resistance value and report back the resistance in ohms. This 
input has 1 property, Analog HS Filter Frequency. That property should be set to 0 so that the input is 
read only once per loop. With symbolic IO enabled, accessing the input would be done from the 
Input_RTD property. 

 

 

VTD INPUT 

VTD inputs refer to inputs that read in a voltage and report back what that voltage is in mV. Generally, this 
is a 0-5V range with the exception of the Battery Voltage Pin. This input has 1 property, Analog HS Filter 
Frequency. That property should be set to 0 so that the input is read only once per loop. With symbolic IO 
enabled, accessing the input would be done from the Input_VTD property. 
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PWM INPUT 

PWM inputs read and report back the on-percentage duty cycle of a square wave signal in a percentage 
of 0-100.0% (real value reported is 0-1000). This input type currently has no adjustable parameters. Using 
the symbolic IO you can access the input value by looking at the Input_PWM property. 

 

 

FREQENCY INPUT 

Frequency inputs read and report back the frequency of a square wave signal in Hz. This input type 
currently has no adjustable parameters. Having the symbolic IO enabled you can access the input value 
by looking at the _Input_Frequency property. 

 

 

COUNTER INPUT 

The counter input is a pulse counter that will report back the number of square wave pulses the input 
experiences over the loop time of the application. The counts will be accumulated based on the falling 
edge detected. There aren’t any adjustable parameters for this input type. If you have the symbolic IO 
enabled you can read the number of pulses by accessing the _Input_Counter property. 
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BUTTONS 

The buttons are grouped together into a single socket called Buttons. Add them to a socket just as you 
would for any other I/O (Right click Plug Device). Double clicking on the object you can view the I/O 
Mapping to see all 4 buttons and the 4 Navigation buttons pre-defined. 

 

If you set up your device to utilize the symbolic IO you can reference the buttons themselves based on 
the Channel Name 

 

Otherwise, you will have to reference them by their Address which can change depending on what socket 
you plugged the Buttons into on the Connector A Device. 
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BUTTON BACKLIGHT 

This is an output that allows you to control the backlight brightness of the buttons. If you have the 
symbolic IO mapping enabled you can access the 2 properties easily to assign a value to. The 
ButtonBacklight_Set_Brightness is what you would assign a value of 0-1000 (100.0%) to control the 
backlight. The second property _Actual_Brightness is what the driver is actually setting the backlight to 
and would only differ from the _Set_Brightness if the controller was throttling the backlight due to thermal 
conditions. Use the _Actual_Brightness for displaying what the backlight is on a visualization and use 
_Set_Brightness to actually control the backlight. 

 

 

KEYSWITCH AND BATTERY INPUTS 

The Keyswitch and Battery Inputs are already pre-socketed into the project when you add the CL-713/CL-
714 device. These monitor battery voltage (in mV) and the switched power pin (TRUE/FALSE for 
detection) for you. With the symbolic IO enabled you can access the values read by them by looking at 
their respective properties. 
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AMBIENT LIGHT SENSOR 

The ambient light sensor is another input that is pre-socketed into the project upon adding the CL-713 
device. This is a sensor that reports back a reading, in lux, based on the amount of light it is exposed to 
where the higher the value the more light it is exposed to. With the symbolic IO enabled you can access 
the value read by the sensor but looking at the sensor property. 

 

 

ENCODER INPUT 

The encoder inputs are a pair of pins that act as 1 input type. These inputs do not have any configurable 
parameters and reading it will return a signed value giving you the amount of change and in which 
direction for that given application loop cycle. You will need to create and maintain your own count within 
your code. With the symbolic IO enabled you can obtain the value by looking at the input parameter. 
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DIGITAL OUTPUT 

Digital outputs are controlled to be ON and OFF without any variance between. These outputs will have a 
few configuration parameters: 

• Softwarefuse trip point: The value in mA in which a software fuse will be set at so that when the 
output is detected to go over that point it will trigger an overcurrent error. 

• Softwarefuse Debounce time: The time in 10mS in which the output current needs to be above 
the trip point for the overcurrent error to trip. 

• OpenCircuit-Detection: A value in mA in which the open circuit detection will turn on when below 
it. 

• Open when Off-Detection-Mode: Can enable or disable the detection for open circuit when off. 
• Load Type: Can enable certain protections on the pin based on the type of load, Load NA and 

Non-Inductive are standard loads and lastly if you are connecting to an inductive load ensure you 
use the Inductive Load type. 

With the symbolic IO enabled, all that needs to happen to turn the output on or off would be to set the 
Boolean parameter true or false. 

 

 

PWM OUTPUT 

The PWM output is an output that has a fixed frequency and a variable duty cycle that you command from 
0-1000 (0-100.0%). This output type has some configurable parameters:  

• Softwarefuse trip point: The value in mA in which a software fuse will be set at so that when the 
output is detected to go over that point it will trigger an overcurrent error. 

• Softwarefuse Debounce time: The time in 10mS in which the output current needs to be above 
the trip point for the overcurrent error to trip. 

• OpenCircuit-Detection: A value in mA in which the open circuit detection will turn on when below 
it. 

• Open when Off-Detection-Mode: Can enable or disable the detection for open circuit when off. 
• Load Type: Can enable certain protections on the pin based on the type of load, Load NA and 

Non-Inductive are standard loads and lastly if you are connecting to an inductive load ensure you 
use the Inductive Load type. 

• Frequency: The frequency in which you desire the output to operate at ranging from 50-1000Hz. 

With the symbolic IO enabled, all that needs to happen to turn the output on or off would be to set the 
output parameter to a value ranging from 0-1000. 
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FREQUENCY OUTPUT 

The Frequency output is an output that has a fixed Duty Cycle and a variable Frequency that you 
command up to 1000Hz. This output type has some configurable parameters:  

• Softwarefuse trip point: The value in mA in which a software fuse will be set at so that when the 
output is detected to go over that point it will trigger an overcurrent error. 

• Softwarefuse Debounce time: The time in 10mS in which the output current needs to be above 
the trip point for the overcurrent error to trip. 

• OpenCircuit-Detection: A value in mA in which the open circuit detection will trip. 
• Open when Off-Detection-Mode: Can enable or disable the detection for open circuit when off. 
• Load Type: Can enable certain protections on the pin based on the type of load, Load NA and 

Non-Inductive are standard loads and lastly if you are connecting to an inductive load ensure you 
use the Inductive Load type. 

• Duty Cycle: Set the Duty Cycle of the signal from 100 to 900 (10.0-90.0%) 

With the symbolic IO enabled, all that needs to happen to turn the output on or off would be to set the 
output parameter to a value ranging from 0-1000 and it will operate at the configured duty cycle with the 
commanded frequency. 

  

 

ECC OUTPUT 

The ECC output is an estimated constant current output, meaning it will try to output a specific amount of 
current that the user commands, in mA. Since there is no feedback to measure the actual current, the 
estimated value is determined internally through circuitry and algorithms. This output has a few things to 
configure with a bit of a nuance. 
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• Softwarefuse trip point: The value in mA in which a software fuse will be set at so that when the 
output is detected to go over that point it will trigger an overcurrent error. 

• Softwarefuse Debounce time: The time in 10mS in which the output current needs to be above 
the trip point for the overcurrent error to trip. 

• OpenCircuit-Detection: A value in mA in which the open circuit detection will turn on when below 
it. 

• Open when Off-Detection-Mode: Can enable or disable the detection for open circuit when off. 
• Load Type: This output will require the load type to be set so you must use the Inductive or Non 

Inductive load type to allow the calculations to run correctly. 
• Frequency: The frequency in which you desire the output to operate at ranging from 50-1000Hz. 
• Duty Cycle Offset: This property is an offset to start the PID output command at a higher setpoint 

to allow for slightly faster response/ramp up to target. 
• P gain: The P Gain term for the internal PID control loop that will run to maintain a constant 

current output. 
• I gain: The I Gain term for the internal PID control loop that will run to maintain a constant current 

output. 
• D gain: The D Gain term for the internal PID control loop that will run to maintain a constant 

current output. 

Having the symbolic IO enabled you can command a current by setting the property to the value you 
desire. 

 

 

BACKLIGHT OUTPUT 

This is an output that allows you to control the backlight brightness of the display. If you have the symbolic 
IO mapping enabled you can access the 2 properties easily to assign a value to. The 
LCDBacklight_Set_Brightness is what you would assign a value of 0-1000 (100.0%) to control the 
backlight. The second property _Actual_Brightness is what the driver is actually setting the backlight to 
and would only differ from the _Set_Brightness if the controller was throttling the backlight due to thermal 
conditions. Use the _Actual_Brightness for displaying what the backlight is on a visualization and use 
_Set_Brightness to actually control the backlight. 
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5V POWER SUPPLY 

The 5V supply is actually 2 pins, a supply (Pin 18) and a return (Pin 17). You will need to plug both into 
sockets in order to use this feature. Both of the pins will have a min and max voltage setting, the min must 
remain below the max. You will want to set your min and max for both pins and then use the _Activate 
property to turn them on (both pins need to be turned on for it to work properly). 

 

 

CAN – SENDING AND RECEIVING CAN MESSAGES/SIGNALS 

There are a few ways of sending and receiving CAN signals but the way we suggest will be through the 
use of a J1939 CAN library stack that is already included with the CL-713/714 Device.  

Before sending or receiving CAN messages, you need to define the CAN bus devices. To begin, right 
click on the HED CL713/CL714 Controller and select Add Device 

 

 

It will open a window where you can expand Fieldbuses. Under Fieldbuses you can select CANbus then 
select CANbus (not NetX CANbus). 
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Double click on your CANbus device to bring up its properties editor. Under the General tab is where you 
select the CAN line and set the baud rate (CAN 1 is Network 0; CAN 2 is Network 1). 

 

 

Once configured, you will need to add the J1939 Device by right clicking on the CANbus Device and 
selecting Add Device. You now have the option to add a J1939 Manager or a CANopen Manager. If you 
have an EDS file, select CANopen. For engine/chassis interfaces select SAE J1939 Manager. 
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It is at the J1939 Manager that you can import DBC files to be used later by your J1939 devices. Under 
the General tab you can Install DBC files as databases to be used later. 

 

 

You are now ready to add a J1939 ECU device – you need to create a separate device for each source 
address your application will be sending or receiving messages. 
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To begin adding messages and/or signals you can double click on the J1939_ECU device to bring up a 
GUI that will allow you to begin configuring that CAN device.  

 

Preferred Address is the Source Address of this device, i.e. most engines would be 0 and some 
transmissions would be 3 or 11 etc. 

Please note, as this is an external device (Local Device is not checked) the messages defined under Tx 
Signals are the messages that will be Received by the CL-713. If you want to use the CAN Device to 
send messages, you need to check Local Devices. 

To add a message that would be transmitted by that remoted device to the display you can go into TX 
Signals and click Add PG 
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By default, there is no database loaded but if you had a database of messages you could choose directly 
from that, otherwise Custom needs to be chosen. Under Custom you can define the parameters of the 
message with a restriction that the PGN (PDU Specific and PDU Format) must remain within the standard 
J1939 defined space – you cannot define a proprietary message for the device configured as is. To define 
a proprietary message, you would need to set the device to a Local Device. 

After adding a PGN you can then begin adding signals to that PGN, defining how long the signal will be, 
scaling, offset, name, byte order, etc. Once the signal is added you can then adjust the bit position in 
which it will start from. 

• Length is the length of this data value in bits 
• Byte Position is the starting bit within the 8 data bytes of the CAN message 
• Bit Position is the starting bit 
• Scaling is a multiplier to the value extracted from the CAN message. 
• Offest is added to the value extracted from the CAN message 

 

To utilize the data you are extracting from CAN messages, simply use the Signal name in your 
application. This line sets a local variable RPM_Command to the Engine_Speed read from a CAN 
message and adds 50 to that value. 

 

Choosing to click the box for Local Device this would designate the ECU device to be a simulated CAN 
device coming from the controller/display itself. You will see that a new tab appears, P2P Rx Signals 
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When set as a local device the Tx Signals are the defined messages that the display will transmit out and 
the P2P RX Signals are the messages it would expect to receive. The Preferred Address in regard to Tx 
Signals is the Source Address that the message will be transmitted with, but in regard to P2P RX Signals 
it would be the Destination Address of the message ID. Adjusting the P2P RX Signal source address will 
be done within that tab directly under the message settings of the PG you have defined. 

To define a message to be transmitted from the display go under Tx Signals, like before, and click the 
Add PG and then define your message under the Custom tab. With the device now selected as local, you 
will be able to define a PGN within the proprietary realm of Identifiers. For these transmitted messages, 
selected the PGN allows you to configure how the message is sent: On Change, Cyclic, etc. 

 

To define a message to be received by the display, you would click the P2P RX Signals and add a PG 
there. Or you can add a new device to receive those messages.  

 

CREATING SCREENS 

Screens are added through the use of visualizations within CODESYS. 

1. Right click on Application and then Add Object->Visualization 
2. It is recommended after the visualization is created to right click on it and adjust the properties 

such that it has a fixed size compatible with the display screen size of 800x480 pixels. 

 
 

3. From here create your HMI as you normally would within CODESYS 
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SWITCHING BETWEEN SCREENS IN YOUR APPLICATION 

If your application has more than one screen, you will need a way to change which screen is being shown 
on the display. There are many methods to do this, and most can be found by doing a quick search on the 
internet or using one of the many CODESYS examples, but here is one of those methods. 

1. Open the Visualization Manager to find the “Use CurrentVisu variable” and ensure that is checked 

 
 

2. Create your separate visualizations 

 
 

3. To change what visualization will be visible you will need to make use of that CurrentVisu variable 
by setting it equal to the visualization you wish to show. 
 

 

This small example is making use of the buttons to change to a specific screen which sets the 
CurrentVisu variable equal to the name of the visualization you wish to have shown. 
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CHANGING OF SPLASH SCREEN 

 

The splash file is a special file that represents the 
image used for the boot time splash screen. This file 
cannot be made within CODESYS, but it can be 
transferred/downloaded from within the CODESYS 
environment. 

To do this you will need to create an image outside of 
the CODESYS environment following a few simple 
rules: 

1. The image type is one of: PNG, BMP, JPG, or 
GIF 

2. The file name is named splash with no file 
extension. 

3. The resolution of the file must be exactly 
800x480. 

Once the file is made you will be able to add it to your 
project by right clicking on Application -> Add Object -> 
External File which will bring up a window for you to 
navigate to the file and select an option:  

 

 

 

Please ensure to keep the Target Path empty, there are internal scripts within the display that will properly 
place the file on the target. You may select “Embed into project” option if you wish to keep the image 
saved/contained within the project itself, though it is not required. 

Once added to the project you should be able to see the splash within your Application tree structure: 

 

After the image is added to the application you may login to your device and download as you normally 
would and application (following section below). That will get the file onto the device, but the splash will 
not be immediately available. The device will need to run some internal scripts on a reboot which will 
relocate the needed file and force another reboot of the device. Upon that second reboot, your splash 
image should appear as the splash going forward. 
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PROGRAMMING DISPLAY THROUGH CODESYS 

By default your display should come with the CODESYS runtime installed on it from the factory. To 
download your CODESYS application to it you will need the M12 USB cable connected to the USB port 
on your display. Power the display up and then plug the USB into your PC. From there you can double-
click on the top level device in your project 

 

Next, under Communication Settings click Scan Network 

 

Once the scanning window comes up you can click the scan network and look for the Linux-Display. 

 

Double-click on the display, you may be asked to create a user management profile for that display if you 
have not done so already, if you have then proceed logging into the user account. After logging in your 
target should show as the Linux Device 
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Once the target is set you can then load your application by selecting the Online->Login, Alt+F8, or 
clicking the log in icon at the top. This will prompt the download of your application. 

 

 

 

PRE-PROGRAMMING OPTION 

We offer a pre-programming option where you provide HED the necessary files and we place your 
application on the display(s) in production so they ship ready to go from the factory. To take advantage of 
this, please work with your HED Sales Representative. 

The file(s) we would need would be the .projecarchive file. To create a project archive: in your project, 
select File -> Project Archive -> Save Archive. Once the file is created send that to us along with any 
permissions information we may need, pending your permissions and user management within the 
project, to open the project to download to a display. 
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